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論理合成プロセス
註 ： 本 Lattice Diamond 日本語マニュ アルは、 日本語によ る理解のため一助と し て提供し ています。 作成にあたっては各 ト ピ ッ クについて可能な限 り 正確を期し てお 

第 5 章 　 論理合成プロセス

5.1 論理合成ツール
　 Lattice Diamond の論理合成ツールには Synplify Pro for Lattice （以下 Synplify Pro） と Lattice Synthesis Engine       
（以下 LSE） があ り ます。 LSE が新規プロ ジェ ク ト 作成時のデフ ォル ト ですが、 指定を変え る こ と ができ ま
す。 LSE を選択し た場合は、 論理合成と一緒に ”Translate Design” プロセス相当の処理も実行されますので、 
プロセス ビ ューには表示されません。

5.1.1 使用する論理合成ツールの選択

　 プロジェ ク ト 作業中に論理合成ツールを選択・変更する方法は複数あ り ます。最初の方法は Lattice Diamond 
の メ ニューバーから [Project] → [Active Implementation] → [Select Synthesis Tool...] を選択し ます （図 5-1）。

図 5-1. 論理合成ツールの選択

　 表示される図 5-2 のよ う な ”Project Properties” ウ ィ ン ド ウで、 左枠でア ク テ ィ ブな イ ンプ リ メ ンテーシ ョ  
ンが選択されている状態で、 右枠表内 Name カ ラ ムの ”Synthesis Tool” 行に、 選択されている論理合成ツール 
が表示されます。 [Value] セルのど こかを ク リ ッ クする と、 プルダウ ン形式で選択可能なツール名が表示され
ます （この例では Synplify Pro と LSE）。 所望のツールを選択後、 『OK』 ボタ ンを ク リ ッ ク し ます。

図 5-2. 論理合成ツールの選択 （プロ ジェ ク ト ・ プロパテ ィ ・ ウ ィ ン ド ウ）
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り ますが、 必ずし も網羅的あ るいは最新でない可能性や、 オ リ ジナル英語版オン ラ イ ンヘルプや各種ド キ ュ メ ン ト と不一致があ る可能性があ り 得ます。 疑義が生じ
た場合は技術サポー ト 担当者にお問い合わせ頂 く か、 または最新の英語オ リ ジナル ・ ソース を参照する よ う にお願い致し ます。
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　 論理合成ツールはイ ンプ リ メ ンテーシ ョ ンご と に指定でき ます。

　 メ ニ ューバーか ら ではない操作方法は、 ア ク テ ィ ブな イ ンプ リ メ ンテーシ ョ ン名を選択後右ク リ ッ ク し、
[Select Synthesis Tool...] を選びます （図 5-3）。 あ るいは同様にア ク テ ィ ブ ・ イ ンプ リ メ ンテーシ ョ ンを右ク   
リ ッ ク後 [Properties] を選択し ます。 いずれも図 5-2 と同じプロパテ ィ ・ ウ ィ ン ド ウが表示されますので、 指 
定を変更でき ます。

図 5-3. 論理合成ツールの指定を変更する方法 ２

5.1.2 論理合成制約フ ァ イルのプロ ジェ ク ト への取 り 込み

　 通常の Lattice Diamond フ ローでは、 論理合成用ス ト ラ テジーの各オプシ ョ ン設定をデザイ ン全体 （グ ロー 
バル） に適用し ます。 例えば、 デザイ ンに 25MHz と 125MHz の二系統の ク ロ ッ クがあ る場合、 ス ト ラ テジー
では両方に 125MHz を制約と し て与え る こ と が基本にな り ます。

　 一方、 論理合成制約フ ァ イル (Synthesis Preference File) を用いる こ と で、 よ り 詳細なコ ン ト ロールが可能  
にな り ます。 この例で言えば 25MHz のク ロ ッ クには 25MHz を、 125MHz のク ロ ッ クには 125MHz の制約を
与え るなど、 ク ロ ッ ク ネ ッ ト ご と に個別に周波数制約を与え る こ と が可能にな り ます。 制約フ ァ イルがな く
て も Diamond フ ローの処理自体には支障あ り ませんが、 論理合成結果 と し ての EDIF の質は異な り ます。 

　 プロジェ ク ト 作成時には、論理合成制約フ ァ イルはあ り ません。作成済み論理合成制約フ ァ イルを イ ンポー
ト するには、 メ ニ ューバーか ら [File] → [Add] → [Existing File...] と 選択するか、 ”File List” ウ ィ ン ド ウ内      
[Synthesis Constraint Files] 行を右ク リ ッ ク し （図 5-4） [Add] → [Existing File...] を選択し ます。

図 5-4. 既存の論理合成制約のイ ンポー ト

　 イ ンポー ト する フ ァ イルの選択ウ ィ ン ド ウ （図 5-5） が立ち上が り （”File of Type” は [Synthesis Constraint    
Files]）、 フ ォルダー内にあ る制約フ ァ イル候補が表示されますので、 ブラ ウズ し て適当なフ ァ イルを選択後、
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『Add』ボタ ンを ク リ ッ ク し ます。LSE 用は拡張子が ”*.ldc”、Synplify Pro 用は拡張子が ”*.fdc”（旧版は ”*.sdc”） 
です。

　 この と き、 ウ ィ ン ド ウ下部の 「Copy file to Implementation’s Source directory」 にチェ ッ クが入っている と、     
イ ンプ リ メ ンテーシ ョ ン下の ”Source” サブフ ォルダーにコ ピーが作成され、 それが イ ンポー ト されます。
チェ ッ クが入っていない場合は、 選択し たフ ァ イルが リ ン ク されて イ ンポー ト されます。

図 5-5. イ ンポー ト する制約フ ァ イルの選択

　 イ ンプ リ メ ンテーシ ョ ンには複数の論理合成制約フ ァ イルを イ ンポー ト する こ と ができ ます。 ア ク テ ィ ブ
な （有効） 制約フ ァ イルは太字で、 非ア ク テ ィ ブな制約フ ァ イルはグレーで表示されます。

　 ア ク テ ィ ブ化と非ア ク テ ィ ブ化の操作は、対象の論理合成制約フ ァ イルをを ク リ ッ ク し て選択し、右ク リ ッ
クする と表示されるプルダウ ンから [Set as Active] または [Set as Inactive] を選択し ます （図 5-6）。

図 5-6. 論理合成制約の非ア ク テ ィ ブ化

　 非ア ク テ ィ ブな論理合成制約フ ァ イルは削除でき ます。図 5-6 と同様に右ク リ ッ ク し [Remove] を選択する 
か、 選択し た状態でキーボード の 『Delete』 キーを押し ます。 ” プロ ジェ ク ト から削除 ” と はイ ンポー ト 情報
の削除で、 フ ァ イル自体の削除ではあ り ません。

5.1.3 OEM 版以外のツールを使用する場合の設定

　 論理合成ツールの実行パス設定を行 う こ と で、 Lattice Diamond 用に提供されている OEM 版論理合成ツー 
ルではないツール や正規バージ ョ ンの Synplify Pro などが使用でき ます。 Lattice Diamond の メ ニューバーか   
ら [Tools] → [Options...] を選択する と環境オプシ ョ ン設定ウ ィ ン ド ウが起動し ます （図 5-7）。 ウ ィ ン ド ウ左    
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側の枠 [Environment] → [Directories] を選択する と、 右側はパス設定入力表示にな り ます。 ウ ィ ン ド ウ上部に  
Synplify Pro と Precision のパス設定セルが用意されています。

図 5-7. Lattice Diamond の環境オプシ ョ ン設定ウ ィ ン ド ウ （一部） ～ ツールパスの設定

　 デフ ォル ト のパスは Synplify Pro は OEM 版が設定され、 Precision はブラ ン クになっています。 必要に応じ 
て これら を変更し ます。 Lattice Diamond にバン ド ルされている Synplify Pro for Lattice を選択し た場合、 ウ ィ    
ン ド ウ右上の 「use OEM」 のチェ ッ クは外さ ないよ う にし、 これ以外の Synplify Pro の場合は、 「use OEM」 の   
チェ ッ ク を外し ます。

5.2 LSE

5.2.1 ス ト ラ テジー ・ オプシ ョ ン設定

　 フ ァ イル リ ス ト ・ ビ ューには、 プロ ジェ ク ト にイ ンポー ト されている ス ト ラ テジーの一覧が表示されてい
ます。 複数あ る中の太字表示が、 イ ンプ リ メ ンテーシ ョ ンに適用されます。 ス ト ラ テジー名をダブルク リ ッ
クする と、 ス ト ラ テジー設定ウ ィ ン ド ウが開き ます。

　 論理合成ツール と し て LSE を指定し ている状態でス ト ラ テジー設定ウ ィ ン ド ウ を立ち上げる と、図 5-8 の 
よ う に ”LSE” が選択されて表示されます。

図 5-8. LSE のス ト ラ テジー設定ウ ィ ン ド ウ

　 以降に LSE のス ト ラ テジー ・ オプシ ョ ンについて記述し ます。 オ リ ジナルの記述はオン ラ イ ンヘルプで
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[Strategy Reference Guide] → [LSE Options] を選択し てご参照頂けます。

Allow Duplicate Modules

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と モジ ュールの複製を許可し ます。

Carry Chain Length

パラ メ ータ : 数値 デフ ォル ト 値 ： 0 （制限な し）

カ ウ ン ターや演算回路で使用される キ ャ リ ー （桁上が り ／下が り ） プ リ ミ テ ィ ブ CCU （Carry Chain 
Cells） の使用数に関するオプシ ョ ンで、 単一キ ャ リ ー ・ チェ イ ンの最大数を指定し ます。

この設定は [Use Carry Chain] オプシ ョ ンが [True] の場合のみ有効です。

Command Line Options

パラ メ ータ : 文字列 デフ ォル ト ： ブラ ン ク

GUI の リ ス ト に表示されていない特別なオプシ ョ ンを使用する場合に、 直接引数等を記述し ます。

DSP Style

パラ メ ータ : DSP/ Logic デフ ォル ト ： DSP

DSP モジュールをどのよ う に実装するかを指定し ます。 デフ ォル ト は DSP マ ク ロ を使用し、 [Logic]
では汎用ロ ジ ッ ク （LUT） を使用し ます。

DSP Utilization

パラ メ ータ : 数値 デフ ォル ト 値 ： 100

DSP マ ク ロ使用率 [%] の上限値を指定し ます。

Decode Unreachable States

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 FSM （ステー ト マシン） が未定義ステー ト に遷移し た場合の動作記述 （”default” ス
テー ト ） を残し ます。

Disable Distributed RAM

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 RTL 記述の メ モ リ ー推論で分散 メ モ リ ー （Distributed Memoy） を使用し た回路を生 
成せずに、 EBR を用います。

EBR Utilization

パラ メ ータ : 数値 デフ ォル ト 値 ： 100

EBR 使用率 [%] の上限値を設定し ます。 設定し た値を超え る場合、 残 り は分散 メ モ リ ー （Distributed
Memory） で実現されます。

FSM Encoding Style

パラ メ ータ : Auto / Binary / Gray / One-Hot デフ ォル ト ： Auto

FSM のステー ト ・ エン コード方式に関する設定です。 Auto （デフ ォル ト ） の場合は、 RTL 記述ステー
ト 数から、 LSE が決定し ます。 その場合、 Gray は 4 ステー ト 未満でのみ指定可能です。

Auto 以外では、 それに従ったエン コード の FSM が生成されます。

Fix Gated Clocks

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト では、 RTL 記述でゲーテ ィ ング し ている ク ロ ッ ク信号を、 FPGA 実装に適する構成に変換
し ます。 対象ク ロ ッ クは .ldc フ ァ イルに ”create_clock” 制約で明記されている必要があ り ます。 また、
変換する ためには全てのゲーテ ィ ング論理が分解でき る こ と、 など一定の条件があ り ます。 変換でき
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ない場合は、 ス キ ューの大きい ク ロ ッ ク ネ ッ ト と し て実装されますので、 注意が必要です （基本的に
ク ロ ッ ク ・ ゲーテ ィ ングはし ないこ と が重要です）。

変換された ク ロ ッ ク と関連情報はロ グフ ァ イル ”synthesis.log” に書き出されます。

Force GSR

パラ メ ータ : Auto / Yes / No デフ ォル ト ： Auto

論理合成時の GSR （Global Set/Reset） 使用に関する設定です。 [Yes] では GSR バッ フ ァ を使用し、 
[No] では使用し ません。 [Auto] では LSE が自動的に判断し ます。

GSR はマ ッ ピング ・ プロセスでよ り 適切な条件で挿入する こ と ができ ます。 意図するマ ッ ピング結
果にな ら ない場合は、 このオプシ ョ ンを [No] にする こ と を推奨し ます。

Hardware Evaluation

パラ メ ータ :  Enable / Disable デフ ォル ト ： Enable

デフ ォル ト （Enable） ではラ イセン スの無い IP コ アを評価可能にするために時限タ イマー （約 4 時
間） を埋め込みます。 IP ラ イセン スが無い状態で [Disable] にする と、 書き込みフ ァ イル （.bit/.jed） は
生成でき ません。 ラ イセン ス入手後の設定はどち らでもかまいません。

Intermediate File Dump

パラ メ ータ :  True / False デフ ォル ト ： False

[True] にする と （EDIF の他に） 暗号化 Verilog HDL フ ァ イルを出力し ます （拡張子 *.ve）。 デフ ォル 
ト （False） では出力されません。 何ら かの問題が生じ た際などに、 固有のデザイ ンをブラ ッ ク ボ ッ ク
ス と し て FAE から技術支援を受ける こ と ができ る よ う にな り ます。

Loop Limit

パラ メ ータ : 数値 デフ ォル ト 値 ： 1950

RTL ソース記述内の ”for” や ”while” ループ回数の最大値を設定し ます。 ループ ・ イ ンデッ ク スが定
数ではな く 変数 と し て定義されている場合にのみ適用されます。 小さすぎ る値は無視されます。 大き
過ぎ る と、 ス タ ッ ク ・ オーバーフ ローを生じ る可能性があ り ますので、 ご注意 く ださい。

図 5-9. MUX Style オプシ ョ ン対象のス ラ イ ス内マルチプレ ク サー

①

②

MUX Style

パラ メ ータ :  Auto / L6Mux Multiple / L6Mux Single / PFU Mux デフ ォル ト ： Auto

マルチプレ クサに関する設定です。 デフ ォル ト （Auto） では LSE が判断し ます。 [PFU Mux] はス ラ 
イ ス内の ”PFU Mux” （図 5-9 ②） と LUT を使用し ます。 [L6Mux Single] はス ラ イ ス内の ”L6Mux” （図   
5-9 ①） を優先的に使用し てマルチプレ クサーを生成し ます。 L6Mux は 4 つの LUT と 2 つの PFUMux
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が ド ラ イブする場合にのみ使われます。[L6Mux Multiple] は複数の ”L6Mux” を優先的に使用し てマルチ 
プレ クサーを生成し ます。

Macro Search Path

パラ メ ータ : フ ォルダーパス デフ ォル ト ： ブラ ン ク

デザイ ンで IP コ ア （ネ ッ ト リ ス ト 提供） やネ ッ ト リ ス ト フ ァ イル （*.ngo） のあ るマ ク ロ を使用し て
いる場合、 そのフ ォルダーパス を指定し ます。 プロ ジ ェ ク ト ・ フ ォルダーに当該フ ァ イルがあ る場合
や、これら を使用し ないデザイ ンではブラ ン ク で構いません。複数のフ ォルダーを指定する場合は、”；”
で区切 り ます （間にスペースは入れない）。 パスの記述は相対パスでも有効です。

Max Fanout Limit

パラ メ ータ : 最大フ ァ ンアウ ト 数 デフ ォル ト 値 ： 1000

フ ァ ンア ウ ト 上限数を制約し ます。 フ ァ ンア ウ ト が こ の値を超えた場合は、 ド ラ イバを コ ピーし て
フ ァ ンア ウ ト を減ら し ます。

Memory Initial Value File Search Path

パラ メ ータ : フ ォルダーパス デフ ォル ト ： ブラ ン ク

EBR （ブロ ッ ク メ モ リ ー） の初期値設定を行 う 際に、 初期値を記述し たフ ァ イル （*.mem） が保存さ
れている フ ォルダーパス を指定し ます。 何も指定し ない場合は、 イ ンプ リ メ ンテーシ ョ ン ・ フ ォルダー
が参照されます。 EBR の初期値設定を行わない場合は、 記述する必要はあ り ません。 また、 モジ ュー
ル生成ツールで生成する際に初期化フ ァ イルを指定し ている場合は、 こ こ で再度指定する必要はあ り
ません。

Number of Critical Paths

パラ メ ータ : パス数 デフ ォル ト 値 ： 3

論理合成結果のタ イ ミ ング ・ レポー ト （<top_module>_lse.twr） に出力する ク リ テ ィ カルパス数を指定
し ます。

Optimization Goal

パラ メ ータ : Area / Balanced / Timing 　 　 デフ ォル ト ： Balanced

[Area] は使用 リ ソース数が最適になる よ う に、 [Timing] は動作速度が最適 （ロ ジ ッ ク段数が最小） に
なる よ う に論理合成を行います。 デフ ォル ト （Balanced） は LDC 制約に従って、 使用 リ ソース数と速
度のバラ ン ス を考慮し て最適化されます。

Propagate Constant

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） では、 固定値が （論理やモジュールの入力に） 接続されている回路を最適化 （削
除） し ます。 [False] を選択する と、 回路は最適化されずに残 り ます。

RAM Style

パラ メ ータ : Auto / Block_RAM / Distributed / Registers デフ ォル ト 値 : Auto

RAM を推定する場合の実現方法 （ リ ソース） を設定し ます。 [Block RAM] では EBR が、 [Distributed] 
は分散 RAM が、 [Registers] ではレジス タがそれぞれ使用されます。 デフ ォル ト （Auto） は LSE が最適
な ものを選択し ます。

ROM Style

パラ メ ータ : Auto / EBR / Logic デフ ォル ト ： Auto

ROM を推定する場合の実現方法 （ リ ソース） を設定し ます。 [EBR] では EBR を使用し、 [Logic] では
分散 メ モ リ かス ラ イ ス内のロ ジ ッ ク リ ソースで構成し ます。 デフ ォル ト （Auto） は LSE が最適な もの
を選択し ます。
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Remove Duplicate Registers

パラ メ ータ : True / False デフ ォル ト ： True

全 く 同じ機能 （論理） のフ リ ッ プフ ロ ッ プが複数あ る場合、 デフ ォル ト （True） では冗長な分を最適
化 （削除） し て リ ソース数を削減し ます。 [False] では削除せずに残し ます。

Remove LOC Properties

パラ メ ータ : On / Off デフ ォル ト ： Off

RTL ソース内記述のポー ト 配置制約 （LOC） に関し て、 デフ ォル ト （Off） では以降のプロセスに引
き継がれます。 [On] にする と、 RTL ソース内の指定は除かれます。

Resolve Mixed Drivers

パラ メ ータ : True / False デフ ォル ト ： False

ア ク テ ィ ブな信号および VCC （または GND） が同時に ド ラ イブし ている場合、 [True] を選択する と
VCC （または GND） に固定し ます。

例えば RTL 記述で図 5-10 のよ う に １ つのネ ッ ト が複数の ド ラ イバに接続されてお り 、 その一方が 
”1=VCC” または ”0=GND” 固定の場合、 [True] では固定値 （0 か 1） と し て処理されます。 メ ッ セージ
（複数 ド ラ イバに よ る信号衝突があ る趣旨） は出力さ れますが、 エ ラーにはな り ません。 デフ ォル ト
（False） では、 エラーと なって処理が中断されます。

なお、 [True] でも [False] でも、 衝突し ている全ての ド ラ イバが固定値でない場合は、 エラーと し て
処理は中断されます。

図 5-10. Resolve Mixed Drivers 処理の例

Resource Sharing

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） で、 使用する リ ソース を減らすために、 複数あ る同一機能の回路を共有させる処
理 （ リ ソース ・ シェ ア リ ング） を行います （図 5-11）。 [False] ではこの処理は行いません。

図 5-11. リ ソース ・ シェア リ ング処理の例

Target Frequency (MHz)

パラ メ ータ : 数値 （周波数） デフ ォル ト 値 ： 200

ク ロ ッ ク周波数 （MHz） ターゲ ッ ト の設定です。 デザイ ン内に複数のク ロ ッ ク があ る場合、 全てが対
象と な り ますが、 LDC 制約で ク ロ ッ ク個別に設定し ている場合は当該ク ロ ッ クは除外されます。

Use Carry Chain

パラ メ ータ : True / False デフ ォル ト ： True
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デフ ォル ト （True） では、 カ ウ ン ターや演算回路に含まれる加算器で、 キ ャ リ ー （桁上が り ／下が
り ） プ リ ミ テ ィ ブ CCU （Carry Chain Cells） の使用を イネーブルし ます。 [False] では使用し ません。

Use IO Insertion

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） では論理合成時に IO バッ フ ァ を挿入し ます。 [False] では挿入し ません。

Use IO Registers

パラ メ ータ :Auto / False / True デフ ォル ト ： Auto

[True] では論理合成時に、 タ イ ミ ング制約を踏まえて、 I/O パッ ド セル内の I/O レジス タ を使用する
こ と を強制し ます。 [False] では I/O レジス タは使用し ません。 デフ ォル ト （Auto） では、 [Optimization
Goal]オプシ ョ ンが[Area]の場合にI/Oレジス タ を使用し ますが、[Timing]や[Balanced]では使用し ません。

Use LPF Created from SDC in Project

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） で LDC 制約に基づいた LPF 制約フ ァ イルを生成し ます。

VHDL 2008

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 プロ ジェ ク ト の VHDL 言語仕様と し て VHDL 2008 を適用し ます。

5.2.2 LDC エデ ィ ターによ る LSE 制約フ ァ イルの生成

5.2.2.1 LDC エデ ィ ターの起動

　 ”LDC エデ ィ ター ” は、 LSE 用の論理合成制約フ ァ イルを作成する GUI ツールです。 メ ニューバーから
[File] → [New] → [File...] の順に選択するか、 フ ァ イル リ ス ト ・ ビ ュー内で [Synthesis Constraint Files] 行を右      
ク リ ッ ク し、 [Add] → [New File...] を選択し ます。 New File Wizard が起動し ます （図 5-13）。

図 5-12. 新規 LDC 論理合成制約フ ァ イルの作成

　 Categories 枠で ”Source Files” を、 ”Source Files” 枠で [LDC Files] を選択し、 「Name」 セルに生成する LDC   
フ ァ イル名を拡張子な しで入力し ます。 適切なフ ォルダーを指定後に 『New』 ボタ ンを ク リ ッ クする と、 LDC
エデ ィ ターが立ち上が り ます。 作成される制約フ ァ イルの拡張子は ”ldc” です。

　 ”Source Files” 枠で [SDC Files] を選択する と、「Name」セル右側にあ る拡張子指定用 ”Ext.” ボタ ンでは ”fdc”  
か ”sdc” が選択でき ます。 この場合、 『New』 ボタ ンを ク リ ッ クする と LDC エデ ィ ターではな く 、 テキス ト
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エデ ィ タが立ち上が り ますので、 手編集し て作成し ます。 文法に精通し ている場合は、 この方法で作成する
こ と ができ ますが、 LSE 用には適用でき ません。

図 5-13. New File ウ ィ ザード （新規 LDC フ ァ イルの追加）

図 5-14. LDC エデ ィ タの初期ウ ィ ン ド ウ

　 LDC エデ ィ ターでは、 該当する タブを選択し て以下の制約設定を行 う こ と ができ ます。

• [Clocks] タブ ： ク ロ ッ ク周期 / 周波数

• [Inputs/Outputs] タブ ： 入出力ポー ト の最大遅延

• [Delay Paths] タブ ： 特定パスのフ ォルスパス / マルチサイ クルパス / 最大遅延

• [Clock Group] タブ ： 任意の ク ロ ッ ク相互関係が非同期、 或いは非依存であ る こ と の指定

• [Generated Clocks] タブ ：ユーザロ ジ ッ ク で生成された （分周） ク ロ ッ クの指定

• [Attribute] タブ ： LSE のサポー ト する Synplify Lattice Attribute 指定

5.2.2.2 ク ロ ッ ク周期指定

ク ロ ッ ク周期指定は [Clocks] タブで行います。 空の ”Source” カ ラ ムを ク リ ッ クする と、 pin/clock
port/clock net 種別がプルダ ウ ンで表示されますので、 意図する も のをダブルク リ ッ ク し ます （図 5-  
15） 。 する と デザイ ン内の ク ロ ッ ク候補が表示されますので、 ダブルク リ ッ ク で選択し ます。 ”Clock
Name” セルに任意の ク ロ ッ ク名 （LSE 内でのみ使用するエイ リ アス名） を、 ”Period(ns)” セルにク ロ ッ
ク周期をそれぞれ入力し ます （図 5-16）。
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図 5-15. ク ロ ッ ク の選択

図 5-16. ク ロ ッ ク名 と周期の指定

　 すべてのタブで共通ですが、 ”Enable” セルに✔印があ る こ と を確認し ます。 無効にする場合は、 印をはず
し ます。

5.2.2.3 入出力ポー ト の遅延指定

入出力ポー ト のタ イ ミ ング制約と し て最小 ・ 最大遅延値 （図 5-17） を指定でき ます。

図 5-17. 入出力遅延

図 5-18. ポー ト タ イプの選択

まず空の ”Type” セルで方向 （Input/Output) を選択し ます （図 5-18）。 次に ”Port” セルを ク リ ッ クす 
る と入力ポー ト の候補がプルダウ ン表示されますので （図 5-19）、ダブルク リ ッ ク し て意図するポー ト 
を選択し ます。
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図 5-19. ポー ト の選択

図 5-20. 最大 ・ 最小遅延指定

同様に ”Clock” セルを ク リ ッ ク し て、 ク ロ ッ クの候補が表示されますので、 タ イ ミ ング制約の対象と
なる ものを選択し て、 ”Value” セルに遅延値を入力し ます （図 5-20）。 ”Max/Min” セルで最小か最大か、 
どち らか一方を指定し ます。 両方を指定する と エラーにな り ます。

5.2.2.4 パス遅延指定

特定パスのタ イ ミ ング制約と し て、 [Delay Paths] タブでマルチサイ クルパス、 フ ォルスパス、 最大パ 
ス遅延をそれぞれ指定を与え る こ と ができ ます （図 5-21）。 ”Delay Type” セルで これらの中からパス遅  
延のタ イプを選択し ます。

図 5-21. Delay Paths でタ イプを選択

マルチサイ クルパス （複数ク ロ ッ ク周期のデータ転送） 指定には、 ”Delay Type” と し て ”Multicycle” 
を 選択 し ま す。 空の ”From” セルや ”To” セル を ク リ ッ ク す る と、 制約対象 と し て pin/port/user
clock/instance の種別が リ ス ト されます。 意図するパスの始点 （From） と終点 （To） と し て種別のいず
れかをダブルク リ ッ クする と、 さ らに対象の候補が展開されて表示されますので （図 5-22）、 ダブルク 
リ ッ ク し て選択し ます。 これを始点と終点の両方について、 或いは一方のみについて行います。

”Cycles” セルに制約値 （ク ロ ッ ク数） を整数値で入力し ます （図 5-23）。 少数値は許容されていませ 
ん。 また、 指定し たパスに複数の経路があ る場合は、 ”Through” セルでネ ッ ト 名を選択する こ と で、 経
路を限定する こ と もでき ます。 ”Max Delay” の入力は不要です。
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図 5-22. マルチサイ クル指定の方法

図 5-23. マルチサイ クル指定後の例

次に、 フ ォルスパス と し て指定されたパスについてはタ イ ミ ング解析の対象から除外し ます。 ”Delay
Type” と し て ”False” を選択し ます。空の ”From” セルや ”To” セルを ク リ ッ ク し て選択する方法は、マ
ルチサイ クル指定と全 く 同じです。 ただし、 ”Cycles” セルの入力は不要です。

図 5-24. 最大パス遅延設定の方法

最後に最大 ・ 最小パス遅延指定です。 ”Delay Type” と し て ”Max_Delay”/”Min_Delay” を選択し ます。 
空の ”From” セルや ”To” セルを ク リ ッ クする と、 制約対象と し て pin/port/instance の種別が リ ス ト さ
れます。

図 5-25. 最大パス遅延の入力後の例

意図するパスの始点 （From） と終点 （To） と し て種別のいずれかをダブルク リ ッ クする と、 さ らに
Lattice Diamond 論理合成プロセス 5-13
©2021 Macnica, Inc.



Rev.3.12
　 対象の候補が展開されて表示されますので （図 5-24） 、 ダブルク リ ッ ク し て選択し ます。 これを始点 
と終点の両方について、 或いは一方のみについて行います。 ”Max Delay”/”Min Delay” セルには制約値  
（単位は ns） を入力し ます （図 5-25 は Max Delay の例）。 Cycle カ ラ ムの入力は不要です。

5.2.2.5 ク ロ ッ ク相互関係の指定

特定の 2 ク ロ ッ ク が非同期関係や非依存の関係にあ る場合、 [Clock Group] タブで明示的に指定する 
こ と で、 タ イ ミ ング解析が不要な こ と をツールに指示し ます。 ”Type” セルで非同期 （asynchronous） か
非依存 （exclusive） かの種別を選択し ます （図 5-26）。

図 5-26. 2 ク ロ ッ ク間の関係の選択

次に二つあ る ”Group” セルで、 ク ロ ッ ク （ブループ） をダブルク リ ッ クする と表示される種別 （図
5-27 の use_clock など） をダブルク リ ッ ク し て展開し、リ ス ト される候補を一度ク リ ッ ク し ます。チェ ッ
ク ・ ボ ッ ク スに印があ る ものが選択されている対象です。 なお、 候補に表示されるのは、 [Clocks] タブ
で ク ロ ッ ク を定義し ているネ ッ ト です。

図 5-27. 対象ク ロ ッ ク の指定例

5.2.2.6 ユーザ生成のク ロ ッ ク指定

ユーザー回路で生成する分周ク ロ ッ ク （”generated clock”） などの指定を行います。

図 5-28. ユーザ生成ク ロ ッ ク の指定
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まず ”Source” セルを ク リ ッ クする と表示される ク ロ ッ ク種別から、 意図する信号を生成するための
大元にな る ピン名をダブルク リ ッ ク し て選択し ます。 ”Name” セルはエイ リ アス名であ り 、 入力は任意
です。 ”Master Clock” は生成ク ロ ッ ク の元になる信号です。

次いで ”Divide Factor” や ”Multiply Factor” 値を整数値で入力し ます。 そし て ”Object” セルを ク リ ッ  
クする と表示される net/pin/clock net 種別のいずれかをダブルク リ ッ ク し て展開し、さ らに意図する生 
成ク ロ ッ ク をダブルク リ ッ ク し て指定し ます。

5.2.2.7 論理合成の属性指定

論理合成の属性 （ア ト リ ビ ュー ト ） を指定し ます。 表記は Synplify Pro 相当です。

図 5-29. ア ト リ ビ ュー ト の選択

まず ”Attribute” セルを ク リ ッ クする と表示される候補から、 意図する ア ト リ ビ ュー ト を選択し ます
　 （図 5-29）。次いで ”Object Type” でプルダウ ン <any>/port/net/register などから対象オブジェ ク ト の  
タ イプを選択し ます。 こ のプルダ ウ ン表示される タ イプはア ト リ ビ ュー ト やデザイ ンに依存し て変わ
り ます。

次にア ト リ ビ ュー ト を適用するオブジェ ク ト を、 ”Object” セルを ク リ ッ クする と プルダウ ン表示さ
れる タ イプのいずれかをダブルク リ ッ ク し、 表示される候補から さ らにダブルク リ ッ ク し て選択し ま
す （図 5-30）。 候補に表示されないア ト リ ビ ュー ト は未サポー ト です。

図 5-30. ア ト リ ビ ュー ト 適用対象オブジェ ク ト の指定

”Value Type” と ”Value” セルは、 選択されたア ト リ ビ ュー ト に準じ て自動的に表示されます。 該当す 
る場合には、 選択可能な候補が表れますので、 それぞれ適宜選択し ます。 ”Description” セルにはア ト リ
ビ ュー ト についての説明が表示されます。

　 なお、 いずれのタブでの設定も、 逐次保存ア イ コ ンを ク リ ッ ク し て保存する こ と を推奨し ます。 その際に、
DRC （ルールチェ ッ ク） が行われ、 問題があれば ”Output” ウ ィ ン ド ウに メ ッ セージが出力されますので、 解
消する よ う にし ます。

　 エラーな く 保存される と、新規作成で LDC エデ ィ ターを起動し た場合は、自動的にイ ンプ リ メ ンテーシ ョ
ンのフ ァ イル リ ス ト ・ ビ ュー内 ”Synthesis Constraint Files” セ ク シ ョ ンにイ ンポー ト されてア ク テ ィ ブ化され  
ます。 再度編集する場合は、 フ ァ イル行をダブルク リ ッ ク し ます。
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5.2.3 ネ ッ ト リ ス ト ・ アナラ イザー

　 LSE を論理合成ツール と し て選択し た場合に、 回路図情報をグ ラ フ ィ カルに閲覧する ツールがネ ッ ト リ ス
ト ・ アナラ イザー （Netlist Analyzer） です。 起動するにはア イ コ ンを ク リ ッ クする （図 5-31、 左） か、 Tools  
メ ニューから選択 （図 5-31、 右） し ます。

図 5-31. ネ ッ ト リ ス ト ・ アナラ イザーの起動

アイコン

　 起動後の初期画面は図 5-32 のよ う にな り ます。ウ ィ ン ド ウ右上の ア イ コ ンを ク リ ッ ク し てウ ィ ン ド ウ

表示枠全体をデタ ッチ （独立に） する こ と を推奨し ます。 実装回路規模が小さい場合を除き、 閲覧するには
細かすぎ るためです。 デフ ォル ト で RTL View スケマテ ィ ッ クが表示されます。

図 5-32. ネ ッ ト リ ス ト ・ アナラ イザー起動後の表示 と ア イ コ ン

　 ア イ コ ン列はウ ィ ン ド ウの左側に並んでいます。 上部には RTL View / Netlist View および Post-MAP View     
各表示を起動する ア イ コ ンなどがあ り ます。

図 5-33. ネ ッ ト リ ス ト ・ アナラ イザーの リ ソース表示
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　 階層構造のデザイ ンの場合、 モジュール階層の上下移動のア イ コ ンを ク リ ッ ク し てから、 スケマテ ィ ッ ク
表示内の （サブ） モジ ュールの箱の上にア イ コ ンを移動する と、 下位階層があ る場合はア イ コ ンが下向き青
矢印表示にな り ます。 ク リ ッ クする と下位階層のスケマテ ィ ッ ク表示にな り ます。 上位階層への移動は何も
回路素子がない位置にア イ コ ンを移動する事で、 上向き緑矢印が表示されますので ク リ ッ ク し ます。

　 ア イ コ ン列下部にはページやシー ト の移動用の左右向き矢印ア イ コ ンがあ り ます。 ア イ コ ン列の右枠は リ
ソース表示ウ ィ ン ド ウで、 イ ン ス タ ン ス、 ポー ト 、 ネ ッ ト 、 ク ロ ッ ク に分類されています。

　 図 5-33 左のよ う に リ ソース種別の行頭 ”>” マーク を ク リ ッ クする と、その下位や内容に展開し てアルフ ァ 
ベッ ト 順に表示し ます。 特定のポー ト やネ ッ ト / ク ロ ッ ク を ク リ ッ ク し て選択する と、 スケマテ ィ ッ ク の該
当 リ ソースが赤色でハイ ラ イ ト されます。

5.2.3.1 オブジ ェ ク ト のサーチ

　 特定の リ ソースやネ ッ ト を探すと きには ”find” 機能があ り ます。 スケマテ ィ ッ ク内で回路記号がブラ ン ク
の領域にマウ ス を移動し て、 右ク リ ッ ク し、 表示 メ ニューから [Find...] を選択し ます。

図 5-34. Find ダ イ ア ロ グの起動

　 表示される図 5-34 のダ イ ア ロ グで、 ①上部タブの [instances] / [Symbols] / [Nets / [Ports] から意図する対       
象 リ ソ ース を選択し ます。 次に② ”Search” セ ク シ ョ ンでサーチ対象の階層を指定し ます。 デフ ォル ト は
”Current Level Only” （ダ イ ア ロ グを立ち上げた際にマウ ス ク リ ッ ク し た階層） です。

図 5-35. Find ダ イ ア ロ グ ・ ウ ィ ン ド ウ
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　 その後、 ③左側に表示される対象候補を選択し て矢印 『->』 など を操作し て ”Highlight” 枠に移動させて
『Close』 を ク リ ッ ク し ます。 各矢印で選択指定と解除を適切に行います。

5.3 Synplify Pro

5.3.1 ス ト ラ テジー ・ オプシ ョ ン設定

　 起動と操作方法は LSE と同じです （図 5-8 参照）。 以降にス ト ラ テジー ・ オプシ ョ ン各設定の詳細を記述 
し ます。

Allow Duplicate Modules

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と モジ ュールの複製を許可し ます。

Area

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と [Frequency] オプシ ョ ンの設定値を無効にし、 使用 リ ソースが最少と なる よ う に最適
化し ます。 SDC/FDC 制約フ ァ イルで ク ロ ッ ク周波数 （周期） を制約し ている場合は、 その設定が優先
されます。

Arrange VHDL Files

パラ メ ータ : True / False デフ ォル ト ： True （VHDL エン ト リ ー時）

デフ ォル ト はデザイ ン ・ エン ト リ ーが VHDL の場合 [True] で、 それ以外では [False] です。 [True] で
は VHDL フ ァ イルを コ ンパイルする際に、 自動的にコ ンパイル順を操作し ます。 [False] ではフ ァ イル
リ ス ト ・ ビ ューで表示されている順に、 上から コ ンパイルされます。

Clock Conversion

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） の場合、 ゲーテ ッ ド ・ ク ロ ッ クや分周ク ロ ッ ク に対し て CE （Clock Enable） ベー 
スの回路に変換し ます。 [False] では変換し ません。

図 5-36. ク ロ ッ ク ・ ゲーテ ィ ングの変換例

図 5-37. 分周ク ロ ッ ク などの変換例
5-18 Lattice Diamond 論理合成プロセス
©2021 Macnica, Inc.



Rev.3.12
Command Line Options

パラ メ ータ : 文字列 デフ ォル ト ： ブラ ン ク

GUI の リ ス ト に表示されていない特別なオプシ ョ ンを使用する場合に、 記述し ます。

Default Enum Encoding

パラ メ ータ : Default / Gray / Onehot / Sequential デフ ォル ト ： Default

VHDL の列挙 （enum） 型変数が定義されている場合、 その実装形式に関する設定です。

デフ ォル ト （Default） では、型の メ ンバ数に応じ て自動的に割 り 振られます。4 以下では ”Sequential”、
40 以上では ”Gray”、 それ以外は ”Onehot” にな り ます。

[Gray] では各 メ ンバーに一度の変化で 1 ビ ッ ト のみが変化する よ う な値が割 り 当て られ（例 :000, 001, 
011, 111, 110, 010）、 [Sequential] では一度に複数 bit が変化する よ う な値 （基本的にはバイナ リ ー ・ カ   
ウ ン ター） が割 り 当て られます。 [Onehot] では各 メ ンバに全ビ ッ ト 中 1 ビ ッ ト のみが '1' と なる値が割
り 当て られます （例 :0001, 0010, 0100, 1000）。

Disable IO Insertion

パラ メ ータ : True / False デフ ォル ト ： False

デフ ォル ト （False） では論理合成時に IO バッ フ ァ を挿入し ます。 [True] では挿入し ません。

I/O バッ フ ァの無いネ ッ ト リ ス ト は配置配線ができ ませんので、IP コ アを生成する などの特殊な場合
を除いて [True] を選択し ないよ う にし ます。

Disable Register Replication during S/R Optimization

パラ メ ータ : True / False デフ ォル ト ： False

シフ ト レジス ターの推論で RAM を生成し た場合に、 デフ ォル ト （False） ではア ド レ スポイ ン ターを
複製し ません。

Export Diamond Settings to Synplify Pro GUI

パラ メ ータ : No / Only on First Launch / Yes デフ ォル ト ： No

Synplify Pro GUI を Tools メ ニューから立ち上げて論理合成処理を行 う 場合に、ス ト ラ テジー設定各オ  
プシ ョ ンをエ ク スポー ト する （渡す） かど う かを指定するオプシ ョ ンです。

[Yes] の場合、 Synplify Pro GUI が起動される ご と にス ト ラ テジー設定を取 り 込み、 それ以前のセ ッ  
シ ョ ンで保存された設定は無効にな り ます。 [Only on First Launch] では、 初回起動時のみにス ト ラ テ   
ジー設定を取 り 込んで起動し、 それ以後はそのセ ッ シ ョ ンでの設定やデフ ォル ト を用いて起動し ます。
デフ ォル ト （No） はオプシ ョ ンを渡し ません。

FSM Compiler

パラ メ ータ : True / False 　 　 デフ ォル ト ： True

デフ ォル ト （True） ではステー ト マシン用のエンジンであ る FSM （Finite State Machine） コ ンパイ ラ  
が使用され、 [False] を選択する と使用されません。 後者では最適な FSM の論理合成結果が得られない
可能性があ り ます。

Fanout Guide

パラ メ ータ : 最大フ ァ ンアウ ト 数 デフ ォル ト 値 ： 1000

フ ァ ンア ウ ト 上限数を制約し ます。 フ ァ ンア ウ ト が こ の値を超えた場合は、 ド ラ イバを コ ピーし て
フ ァ ンアウ ト を減ら し ます。 デザイ ン全体に適用されます。 一方、 Synplify Pro では特定のネ ッ ト （信 
号） に限定 し て フ ァ ン ア ウ ト を制限す る ために、 RTL ソ ース コ ー ド に以下の記述を し て も 有効で
す。 ”100” が意図する上限値の場合の例です。

Verilog wire <object_name> /* synthesis syn_maxfan = 100 */ ; // wire can be reg

VHDL signal <object_name>: std_logic;

attribute syn_maxfan: integer;

attribute syn_maxfan of <object_name>: signal is "100" ;
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Force GSR

パラ メ ータ : Auto / False / True デフ ォル ト ： False

論理合成時の GSR （Global Set/Reset） 使用に関する設定です。 [True] では GSR バッ フ ァ を使用し、 
[False] では使用し ません。 [Auto] では Synplify Pro が自動的に判断し ます。

GSR はマ ッ ピング ・ プロセスでよ り 適切な条件で挿入する こ と ができ ます。 意図するマ ッ ピング結
果にな ら ない場合は、 このオプシ ョ ンを [False] にする こ と を推奨し ます。

Frequency （MHz）

パラ メ ータ : 周波数 デフ ォル ト 値 : な し

ク ロ ッ ク周波数 （MHz） ターゲ ッ ト の設定で、 [Area] オプシ ョ ンが [False] の場合のみ有効です。 デ
ザイ ン内に複数の ク ロ ッ クがあ る場合、 全てが対象と な り ますが、 SDC/FDC 制約で ク ロ ッ ク個別に設
定し ている場合は当該ク ロ ッ クは除外されます。

ブラ ン ク時はク ロ ッ ク周波数が最大になる よ う に振る舞います。

Library Directories

パラ メ ータ : デ ィ レ ク ト リ ー デフ ォル ト ： ブラ ン ク

デザイ ンに含まれる Verilog ラ イブラ リ ーのデ ィ レ ク ト リ ー ・ パス を指定し ます。 フ ァ イル名はモ
ジュール名と一致し ている必要があ り ます。

Number of Critical Paths

パラ メ ータ : パス数 デフ ォル ト 値 : な し

論理合成結果のタ イ ミ ング ・ レポー ト に出力する ク リ テ ィ カルパス数を指定し ます。

Number of Start/End points

パラ メ ータ : 数値 デフ ォル ト 値 : な し

論理合成結果のタ イ ミ ング ・ レポー ト に出力するパス数の設定です。 この値が 1 以上の場合のみに 　
[Number of Critical Paths] が有効です。

Output Netlist Format

パラ メ ータ : None / VHDL / Verilog デフ ォル ト ： None

論理合成後シ ミ ュ レーシ ョ ン用のネ ッ ト リ ス ト 出力設定です。 デフ ォル ト （None） では EDIF のみが
出力されます。 [VHDL] では EDIF と VHDL ネ ッ ト リ ス ト （*.vhm） が出力され、 [Verilog] では EDIF と
Verilog HDL ネ ッ ト リ ス ト （*.vm） が出力されます。

Pipelining and Retiming

パラ メ ータ : None / Pipelining Only / Pipelining and Retiming デフ ォル ト ： Pipelining Only

論理合成中に行 う タ イ ミ ングの最適化処理 ”Retiming （ リ タ イ ミ ング） ” と ”Pipelining （パイプラ イ ン
化） ” に関する設定です。

図 5-38. リ タ イ ミ ング処理の例

リ タ イ ミ ングは組み合わせ回路を移動し てレジス タ間同士の遅延量のバラ ン ス を と る よ う にする処
理です （図 5-38）。 回路全体に対し て この処理が行われます。 他方、 パイプラ イ ン化は主に演算回路に 
対し て行 う 処理で、 回路の中間にレジス タ （パイ プラ イ ン ・ レジス タ） を挿入する も のです。 後者で
は入力から出力が得られる までのサイ クル数が、 RTL 記述と は異なる可能性があ り ます。
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デフ ォル ト （Pipelining Only） はパイプラ イ ン化のみ、 [Pipelining and Retiming] は両方を行います。   
[None] ではどち ら も行いません。

Push Tristates

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） では、 ハイ イ ンピーダン ス 'Z' がレジス タ を介し てポー ト に出力される よ う な記
述に対し て、 ト ラ イ ステー ト 制御用レジス タ を追加し、 IO バッ フ ァ で ト ラ イ ステー ト 制御を行 う よ う
に回路を論理合成し ます （図 5-39）。

[False] では、 FPGA 内部で 'Z' が生成されないよ う な回路が論理合成されます。

図 5-39. Push Tristate オプシ ョ ンの効果

Resolve Mixed Drivers

パラ メ ータ : True / False デフ ォル ト ： False

ア ク テ ィ ブな信号および VCC （または GND） が同時に ド ラ イブし ている場合、 [True] を選択する と
VCC （または GND） に固定し ます （図 5-10 参照）。

Resource Sharing

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） で、 使用する リ ソース を減らすために、 複数あ る同一機能の回路を共有させる処
理 （ リ ソース ・ シェア リ ング） を行います （図 5-11 参照）。 [False] ではこの処理は行いません。

Update Compile Point Timing Data

パラ メ ータ : True / False デフ ォル ト ： False

コ ンパイルポイ ン ト （compile point） はイ ン ク リ メ ン タル ・ デザイ ンフ ローに関する機構です。

階層構造の下位モジ ュールが変更された場合に、 デフ ォル ト （False） ではその上位モジ ュールは再
合成されませんが、 [True] を選択し た場合は、 上位モジュールが再び論理合成されます。 下位モジュー
ルの変更に伴い、 タ イ ミ ング ・ データ と タ イ ム ス タ ンプが更新されます。

Use Clock Period for Unconstrained I/O

パラ メ ータ : True / False デフ ォル ト ： False

デフ ォル ト （False） では SDC/FDC フ ァ イルでタ イ ミ ング制約が与え られていなる I/O についての
み制約を適用し ます。 [True] にする と未制約の I/O にも同じ制約が与え られます。 

Use LPF Created from SDC in Project

パラ メ ータ : True / False デフ ォル ト ： True

デフ ォル ト （True） では SDC/FDC 制約フ ァ イルの記述を LPF 制約に変換し て出力し ます （コ メ ン
ト ア ウ ト されている）。 フ ァ イル名は <project-name>_<implementation-name>_synplify.lpf で、 イ ンプ リ メ
ンテーシ ョ ン ・ フ ォルダー下に生成されます。
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VHDL 2008

パラ メ ータ : True / False デフ ォル ト ： False

[True] にする と、 プロ ジェ ク ト の VHDL 言語仕様と し て VHDL 2008 を適用し ます。

5.3.2 SCOPE エデ ィ ターによ る制約フ ァ イル fdc の生成

　 Synplify Pro が備え る制約エデ ィ タ GUI であ る ”SCOPE エデ ィ ター ” を用いて ”Synopsis Design Constraint”   
と し ての fdc （FPGA Design Constraints） フ ァ イルが容易に生成でき ます。 以下に論理合成時に適用する制約  
フ ァ イル ”*.fdc” を新規に生成する方法を記述し ます。 RTL の文法エラー等はすべて解消されている もの と
し ます（詳細は Synplify Pro ド キ ュ メ ン ト fpga_user_guide.pdf の ”Specifying Constraints” 章）をご参照 く ださい）。

　 なお、 バージ ョ ン G-2012L.09 以降 （Diamond 3.0 以降） は、 ”sdc” フ ァ イルによ る制約設定が ”fdc” を用い 
る構成に更新されま し た （Diamond 3.12 のバージ ョ ンは Q-2020L.03-SP1） 。 従来のレガシー sdc （Synplify 
Design Constraint） を用いる こ と も可能ですが、 新規デザイ ンには推奨されません。 Synplify Pro には sdc か  
ら fdc への変換コマン ド ”sdc2fdc” がサポー ト されていますので、 合わせて ド キ ュ メ ン ト をご参照 く ださい。

図 5-40. 『Run』 またはコ ンパイルのみを実行

5.3.2.1 SCOPE エデ ィ ターの起動

　 まず Lattice Diamond から Synplify Pro を単独で立ち上げます。 ト ッ プで左上の大きなボタ ン 『Run』 を ク  
リ ッ クするか、 [Run] メ ニューから [Compile Only] を選択し てコ ンパイルし ます （図 5-40）。 RTL エラーで処  
理が完了し ない と次のステ ッ プができ ませんので、 ご注意 く だ さい。

　 次に メ ニューから [File] → [New...] を選択し て ”New” ウ ィ ン ド ウ を立ち上げます （図 5-41）。

図 5-41. SCOPE エデ ィ タの起動

　 fdc フ ァ イルの生成のため ”FPGA Design Constraints” を選択し、 丸印内の 「New File Name」 セルにフ ァ イ    
ル名を入力し、 「File Location」 をブラ ウ ズ し て指定し た後、 『OK』 を ク リ ッ ク し ます。 これによ り 、 図 5-42
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に示すよ う な制約設定用ワーク シー ト ”SCOPE エデ ィ ター ” が立ち上が り ます。

図 5-42. “FPGA Design Constraints” 入力用ワーク シー ト GUI

　 ウ ィ ン ド ウの下部には複数のタブがあ り ます。 ク ロ ッ ク制約を与え る [Clocks] タブや I/O ポー ト に対する
制約の [Inputs/Outputs] タブなどを選択し た後に、 それぞれを入力し ていき ます。

5.3.2.2 ク ロ ッ ク制約の設定

　 ク ロ ッ クについては、 タブを選択後、 空白の ”Object” セルを ク リ ッ クする と その右端に▼印が表示されま
すので、 これを ク リ ッ ク し て現れるプルダウ ンの候補から選択し ます。 その後最低限 ”Name” に適切な名称
を、 ”Period” セルの周期 [ns] を与えます。 ”Enable” セル表示に✔印が付いている こ と を確認し ます。 無効に
する場合はこの印を消し ます。

図 5-43. ク ロ ッ ク ・ オブジェ ク ト の選択

　 プルダウ ンに意図する候補が表示されない場合などは、 ク ロ ッ ク ネ ッ ト やポー ト のオブジェ ク ト を RTL ス
ケマテ ィ ッ ク ・ビ ューGUI から ド ラ ッ グ＆ド ロ ッ プする入力方法があ り ます。その場合は、まず上部 メ ニュー
バー内の RTL ビ ューア イ コ ン （図 5-44 右図の赤枠） を ク リ ッ ク し て、 RTL スケマテ ィ ッ ク ・ ビ ューを表示 
させます。なお、 ビ ューの表示形式を旧バージ ョ ン相当にし たい場合は、 メ ニ ューから [HDL Analyst] → [Use 
Legacy HDL Analyst (obsolete)] を選択し ておき ます （図 5-44 左図）。

図 5-44. RTl ビ ューの起動 （右） と ” レガシー ” 表示の選択 （左）

　 次に図 5-45 右下の丸印で示す、 ビ ューの右上端にあ る ”Restore Down” ア イ コ ン （どの表示でも構わない）  
を ク リ ッ ク し て、 複数のウ ィ ン ド ウ間でマウ ス移動ができ る よ う にし ます。
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　 FPGA Design Constraints で [Clocks] タブを選択し、 適切な表示位置に移動し ておき ます。

図 5-45. オブジェ ク ト の ド ラ ッ グ＆ド ロ ッ プ と ウ ィ ン ド ウの個別表示ア イ コ ン （右下）

• RTL ビ ューの左枠で Instances や Nets 項をエ ク スパン ド し て意図する ク ロ ッ ク ネ ッ ト を選択し ます
（図 5-45 左の赤印が選択された状態）

• RTL ビ ューで赤線の当該ク ロ ッ ク ネ ッ ト を ク リ ッ ク し て選択し た状態で、 マウ ス を ド ラ ッ グ し て
”Object” セルに ド ロ ッ プし ます （図 5-45、 中央上）

　 前と同様に ”Name” と ”Period” などを入力し ます。 これを必要な ク ロ ッ ク ネ ッ ト 分だけ繰 り 返し ます。 以
上が ク ロ ッ ク制約の設定手順です。

　 I/O タ イ ミ ングについて も同様に入力し ます。

5.3.2.3 コ ンパイルポイ ン ト の設定

　 モジ ュールにコ ンパイルポ イ ン ト （Compile point） を設定し て論理合成する と、 特に規模の大き なデザイ 
ンでは論理合成時間を短縮でき ます。 論理合成の実行時にコ ンパイルポイ ン ト ご と に作成されるデータベー
ス を参照し て、 変更されている ソース フ ァ イルのみの論理合成を行います。

図 5-46. コ ンパイルポ イ ン ト タ イプによ る最適化の違い

　 ”soft” はモジ ュール間の接続分の回路を ま と めて最適化し ます。 ”hard” の場合は接続部分の回路を コ ンパ
イルポイ ン ト ご と に個別に最適化し ます。 ”locked” では接続部分の最適化は行われません。

　 fdc フ ァ イルを直接編集し てコ ンパイルポイ ン ト を設定する場合の文法は、 以下のよ う にな り ます。

define_compile_point {v:work.< モジュール名 >} -type {< コ ンパイルポイ ン ト ・ タ イプ >}

　 ”work” はラ イブラ リ ー名 （デフ ォル ト ） です。 コ ンパイルポイ ン ト タ イプは、 モジュール間の接続部分の
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論理合成に関する設定で、 soft / hard / locked から １ つを選択し ます。

図 5-47. SCOPE によ る コ ンパイルポイ ン ト の設定 １

図 5-48. SCOPE によ る コ ンパイルポイ ン ト の設定 ２

　 SCOPE ワーク シー ト で設定する場合、 [Compile Point] タブを選択後、 空白の ”View” セルを ク リ ッ クする 
と その右端に▼印が表示されますので （図 5-47） 、 これを ク リ ッ ク し て現れるプルダウ ンの候補から選択し 
ます。次に ”Type” セルを ク リ ッ ク し、同様にプルダウ ンから意図する タ イプを指定し ます（図 5-48）。”Enable” 
セル表示に✔印が付いている こ と を確認し ます。 無効にする場合はこの印を消し ます。

5.3.2.4 fdc 制約フ ァ イルのプロジ ェ ク ト への取り込み

　 制約フ ァ イル保存時に作業プロ ジェ ク ト に含めるかど う かを問われます。 生成が完了し た後、 プロ ジェ ク
ト 表示ウ ィ ン ド ウ （[Project Files] タブ） で図 5-49 のよ う に ”Logic Constraints (FDC)” 部にフ ァ イル名が表示    
されていれば、 意図する とお り の動作です。

図 5-49. 制約フ ァ イル fdc の リ ス ト 表示

　 オフ ラ イ ンで fdc を作成し た場合など、 フ ァ イル名が リ ス ト されていない場合は、 GUI ト ッ プ左枠内 [Add
File...] を ク リ ッ クする と表れる ウ ィ ン ド ウで指定し ます。 この際、 ”File of types” で拡張子 ”*.fdc” を指定し  
た後に上部枠内でブラ ウズ し ます （図 5-50）。 対象フ ァ イルを選択後、 右下の 『Add』 を ク リ ッ ク し、 『OK』 
を ク リ ッ ク し て抜けます。 以上によ って図 5-49 と同様にプロ ジェ ク ト に取 り 込まれた リ ス ト 表示にする こ 
と ができ ます。

　 これは GUI 起動し て作業する論理合成プロ ジェ ク ト のみに対し てであ る こ と に留意する必要があ り ます。
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図 5-50. fdc フ ァ イルの取 り 込み方法 ２ ： 指定後 Add し て OK

5.3.2.5 fdc 制約フ ァ イルの Diamond への反映

　 作成し た fdc フ ァ イルを、 Synplify Pro GUI を起動し ない、 通常の Diamond フ ローにも適用される よ う にす  
るためには、 Diamond のフ ァ イル リ ス ト ・ビ ュー内のイ ンプ リ メ ンテーシ ョ ン下 ”Synthesis Constraint File” セ   
ク シ ョ ンに取 り 込み、 ア ク テ ィ ブ化する必要があ り ます （図 5-51） 。 ア ク テ ィ ブ （太字表示） でない と、 有 
効にな り ませんのでご注意 く ださい。 また、 これはイ ンプ リ メ ンテーシ ョ ンご と に行 う 必要があ り ます。

図 5-51. 制約フ ァ イル fdc の Diamond フ ローへの反映

5.3.3 Synplify Pro ド キ ュ メ ン ト

　 Synplify Pro の使用方法やオプシ ョ ン設定に関する各種のガ イ ド ラ イ ン ・ ド キ ュ メ ン ト は、 以下のフ ォル 
ダーにイ ン ス ト ールされています （Diamond 3.12 をデフ ォル ト 設定でイ ン ス ト ールし た場合） 。 これらは、 
Synplify Pro GUI の メ ニューから [Help] → [PDF Documents] でも呼び出すこ と ができ ます。

C:\lscc\diamond\3.12\synpbase\doc

fpga_user_guide.pdf : 主に GUI 操作を含むデザイ ンフ ロー全般についての記述

fpga_hdl_reference.pdf : HDL 言語サポー ト 機能についての詳細記述 （Verilog/VHDL/System Verilog）

fpga_attribute_reference.pdf : 論理合成ア ト リ ビ ュー ト （属性） についての記述

5.4 論理合成 HDL ア ト リ ビ ュー ト 記述例
　 LSE と Synplify Pro でサポー ト する HDL ア ト リ ビ ュー ト の参考を、 い く つかの例を示し ます。
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VHDL 例

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す）

attribute syn_keep : boolean; -- ワ イヤ （ノード） の保持

attribute syn_keep of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

attribute syn_preserve : boolean; -- FF の保持

attribute syn_preserve of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

attribute syn_noprune : boolean; -- 出力がない リ ソース削除の禁止

attribute syn_noprune of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

（FSM のコーデ ィ ング方式）

attribute syn_encoding : boolean; -- [sequential, binary, onehot], 他に safe （”default” 記述有効化）

attribute syn_encoding of <fsm_nodes>: signal is “safe, Boolean”; --“fsm_nodes” は signal 定義し た FSM 名

Verilog HDL 例

（I/O タ イプ指定、 ポー ト 宣言行）

input CLKIN /* synthesis IO_TYPE="LVCMOS18" */ ;

output CLKOUT /* synthesis IO_TYPE="LVDS25E" */ ; 

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す。 ノード定義行）

reg [x:0] <FF_name> /* synthesis syn_preserve=1 */;

wire [y:0] <wire_name> /* synthesis syn_keep=1 */;

（FSM のコーデ ィ ング方式。 FSM ノード定義行）

reg [z:0] <FF_FSM_name> /* synthesis syn_encoding=”safe, binary” */;

5.5 Translate Design
　 Translate Design は Synplify Pro で生成された EDIF フ ァ イルをバイナ リ 形式のデータに変換するプロセスで  
す。 EDIF 内ではブラ ッ ク ボ ッ ク ス扱い と なっている IP コ アやマ ク ロ を、 ネ ッ ト リ ス ト に置き換えて結合す
る処理も行います。 論理合成ツール と し て LSE を選択し た場合、 Translate Design プロセスはあ り ません。

図 5-52. Translate Design のス ト ラ テジー設定 GUI
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5.5.1 Translate Design プロセスのス ト ラ テジー設定

　 フ ァ イル リ ス ト ・ ビ ューに、 プロ ジェ ク ト にイ ンポー ト されている ス ト ラ テジーの一覧が表示されていま
す （イ ンプ リ メ ンテーシ ョ ンで使用されるのは、 太字で表示されている １ つだけです）。 この中から変更し た
いス ト ラ テジー名をダブルク リ ッ クする と、 ス ト ラ テジー設定ウ ィ ン ド ウが開き ます。 ス ト ラ テジーはプロ
セスご と に表示されていますので、 左側の ”Process” 枠で ”Translate Design” を選択し ます ( 図 5-52)。

5.5.2 ス ト ラ テジー項目の詳細

　 以下に ス ト ラ テ ジー ・ オプシ ョ ン を記述 し ま す。 オ リ ジナルの記述はオ ン ラ イ ンヘルプで [Strategy
Reference Guide] → [Translate Design Options] を選択し てご参照頂けます。

Command Line Options

パラ メ ータ ： 文字列 デフ ォル ト ： ブラ ン ク

本プロセスのコマン ド EDIF2NGD に特別なオプシ ョ ンを使用する場合に、 直接引数等を記述し ます。

Consistent Bus Name Conversion

パラ メ ータ : Lattice / None / Precision / Synplify デフ ォル ト ： None

バス信号の表記方法についてのオプションです。

Hardware Evaluation

パラ メ ータ : Enable / Disable デフ ォル ト ： Enable

デフ ォル ト （Enable） ではラ イセン スの無い IP コ アを評価可能にするために時限タ イマー （約 4 時間）
を埋め込みます。 IP ラ イセン スが無い状態で [Disable] にする と、 書き込みフ ァ イル （.bit/.jed） は生成
でき ません。 ラ イセン ス入手後の設定はどち らでもかまいません。

Macro Search Path

パラ メ ータ ： 文字列 デフ ォル ト ： ブラ ン ク

デザイ ンで IP コ ア （ネ ッ ト リ ス ト 提供） やネ ッ ト リ ス ト フ ァ イル （*.ngo） のあ るマ ク ロ を使用し て
いる場合、 そのフ ォルダーパス を指定し ます。 プロ ジ ェ ク ト ・ フ ォルダーに当該フ ァ イルがあ る場合
や、これら を使用し ないデザイ ンではブラ ン ク で構いません。複数のフ ォルダーを指定する場合は、”；”
で区切 り ます （間にスペースは入れない）。 パスの記述は相対パスでも有効です。

Memory Initial Value File Search Path

パラ メ ータ ： 文字列 デフ ォル ト ： ブラ ン ク

EBR （ブロ ッ ク メ モ リ ー） の初期値設定を行 う 際に、 初期値を記述し たフ ァ イル （*.mem） が保存さ
れている フ ォルダーパス を指定し ます。何も指定し ない場合は、 イ ンプ リ メ ンテーシ ョ ン ・ フ ォルダー
が参照されます。 EBR の初期値設定を行わない場合は、 記述する必要はあ り ません。 また、 モジ ュー
ル生成ツールで生成する際に初期化フ ァ イルを指定し ている場合は、 こ こ で再度指定する必要はあ り
ません。

Partition Search Path

パラ メ ータ ： 文字列 デフ ォル ト ： ブラ ン ク

デザイ ンで定義し たパーテ ィ シ ョ ンのネ ッ ト リ ス ト フ ァ イル （*.ngo） を使用し ている場合、 そのフ ォ
ルダーパス を指定し ます。

Remove LOC Properties

パラ メ ータ : Off / On デフ ォル ト 値 ： Off

RTL ソース内記述のポー ト 配置制約 （LOC） に関し て、 デフ ォル ト （Off） では以降のプロセスに引
き継がれます。 [On] にする と、 RTL ソース内の指定は除かれます。
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5.5.3 Translate Design レポー ト

　 Translate Design プロセスでは専用のレポー ト フ ァ イルが出力されません。処理の経過や Error / Warning な   
どの メ ッ セージは全て Lattice Diamond のロ グフ ァ イルであ る ”automake.log” に出力されます。 Diamond GUI  
の下部 『Output』 ビ ューにも同時に表示されます。

5.5.3.1 Error / Warning メ ッ セージ

　 本項では良 く 出る Warning および Error メ ッ セージ と、 その原因について記述し ます。

　 メ ッ セージ ERROR - ngdbuild: logical net ' 信号 ' has multiple drivers

意味

　 指定された信号名が複数のイ ン ス タ ン スの出力ポー ト に接続されている と い う メ ッ セージです。*.ngo 形
式の IP を使用し ているデザイ ンで、 IP に I/O バッ フ ァが含まれている場合に出力されます。

対策

　 論理合成のス ト ラ テジー ”Disable IO Insertion” を [False] に設定し、 I/O バッ フ ァ を挿入し ないで論理合  
成から再実行し て ngo フ ァ イルを再生成し ます。

　 メ ッ セージ WARNING - ngdbuild: logical net ' イ ンス タ ンス / 信号 ' has no load

意味

　 ネ ッ ト / 信号の出力がオープンであ る （負荷がない） 意味のウ ォーニングです。

対策

　 論理合成やマ ッ ピングのレポー ト を確認し、 想定外の最適化などの問題がない場合は、 無視し ます。 意
図し ないネ ッ ト / 信号に対し ての場合は、 RTL 記述などで接続を修正し ます。

　 メ ッ セージ ERROR - ngdbuild: logical block ' イ ンス タ ンス ' with type ' モジュール ' is unexpanded

意味

　 論理合成でブラ ッ ク ボ ッ ク ス指定し ている イ ン ス タ ン スがあ り 、 その IP やモジ ュールに相当する *.ngo
フ ァ イルが見つから ない場合の メ ッ セージです。

対策

　 当該モジ ュールの *.ngo フ ァ イルをプロ ジェ ク ト フ ォルダー下にコ ピーするか、ス ト ラ テジー・オプシ ョ
ン ”Macro Search Path” にそのパス を記述し ます。

--- *** ---
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